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1 Introduction

This manual explains the installation, configuration and usage of the payment module for
OpencCart and ExperCash.

Before beginning with the installation, please make sure that you are in possession of all
necessary data:

® ExperCash ProjectID

® ExperCashSecurity ID

e ExperCash FramelD

® ExperCash Frame Key

® QOpenCart payment module by sellxed.com/shop
® Access data to your server and shop

In case you don't yet have a contract with ExperCash, you can gladly acquire it directly through us.

Note that you must use at least PHP version 5.6 for our plugins. PHP 8 or higher is currently not
supported.

1.1 Process of the Installation

In this document you will find all important information for the installation of the module. It is
important that you strictly follow the checklist. Only by doing so, can a secure usage in
correspondence with all security regulations be guaranteed.
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1. Configuration of the basic settings of the payment module

2. Configuration of the payment methods

3. Carrying out of a test purchase by means of the attached test data at the end of this
document

4. If the test was successful, your account can be activated

Installation Service

Our payment plugins should have per default the correct settings for most of our
customers' preferences. That means once you have entered the required credentials in
the plugin configuration to connect your account to your website, the plugin should be
fully operational. Should you be willing to receive detailed information on a setting you
do not know, you may contact our support team who will be able to assist you further.

Our support team is at your disposal during regular business hours at: http://www.
sellxed.com/support. Furthermore, you have the option of ordering our installation
service. We will make sure the plugin is installed correctly in your shop: http://www.
sellxed.com/shop/de/integration-und-installation.html

.htaccess Directory Protection

In order to test the module, any kind of directory protection or IP blocking on your server
must be deactivated. This is crucial as otherwise the payment feedback of ExperCash
might not get through to the shop.

1.2 System Requirements

In general, the plugin has the same system requirements as OpenCart. Below you can find the
most important requirements of the plugin:

® PHP Version: 5.4.x or higher

® OpenSSL: Current version with support for TLS 1.2 or higher.

* fsockopen: The PHP function fsockopen must be enabled. The plugin must be able to
connect to external systems over the Internet.

® PHP Functions: All common PHP functions must be enabled.

In case you are using OpencCart version 3.0.3.5 or 3.0.3.6, you must patch your store to fix the twig
extension error in order for modified templates to be loaded. The following extension can be
used to resolve the issue: https://www.opencart.com/index.php?route=marketplace/extension

/info&extension_ id=40469.
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2 Configuration of the Payment Module and
the Payment Methods

For the usage of the gateway in your shop, enter the obtained access data in the main module
and in the payment methods in its respective place within.
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3 Module Installation and Update in the
OpencCart Shop

3.1 Installation

At this time you should already be in possession of the module. Should this not be the case, you
can download the necessary files in your customer account in the sellxed shop (Menu "My
Downloads Downloads"). In order to install the module in your shop, please carry out the
following steps:

1. Download the plugin. The download can be found in your sellxed.com account under "My
Downloads".

2. Unzip the archive you have just downloaded.

3. Inthe unzipped folder navigate to the folder "files"

4. For some shops there are different versions of the plugin provided. If this is the case open
the folder which corresponds to your shop version.

5. Usingyour preferred FTP client upload entire content of this folder into the root directory
of your shop. For some shops there is a specific folder containing the plugins. If that is the
case upload the plugin into this folder. Make sure that the folders aren't replaced but
merely merged.

6. If you haven't yet done so, log back into your shop.

3.2 Updates and Upgrades

You have direct and unlimited access to updates and upgrades during the duration of your
support contract. In order to receive constant information about available updates we ask you to
subscribe to our RSS feed that we publish for your module.

More information regarding the subscription of this RSS feed can be found under: http://www.
sellxed.com/en/updates_upgrades.

We only recommend an update if something doesn't work in your shop, if you want to use new
feature or if there is a necessary security update.

3.2.1 Update Checklist

We ask you to strictly comply with the checklist below when doing an update:
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1. Always do a backup for your database and your files in your shop

2. Use always a test system to test the update process.

3. Wait until all the files are copied to the shop, clear the cache if there is one in your shop
and then visit the configuration page of the main module so that the update process will
be initialized.

Do not do updates directly in the live environment

Please test the update procedure first in your test shop. Our support team is able and
willing to help you if you experience problems with the update process. However, if you
decide to perform the update directly in your live shop there is the possibility of a
downtime of the shop of more than two days depending on the availability of our support
if you do not want to book our complementary support.

Depending on the version it could be that the database has to be migrated. We recommend you
therefore, to perform the updates in times when the shop is not visited too frequently by your
customers.

3.2.2 Update Instructions

Please always read the update instruction. Those instructions can be found in the changelog. If
there are no special remarks, you can proceed by just overwriting the files in your system.
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4 Module Configuration in the OpencCart Shop

The configuration consists of two steps. The first step is the configuration of the main module
with all the basic settings (cf. Configuration of the Main Module). During the second step you can
then carry out individual configurations for each payment method . This allows for full flexibility
and perfect adaptation to your processes.

Create backups!

Please create a backup of the main directory of your shop. In case of problems you will
then always be able to return your shop to its original state.

We furthermore recommend testing the integration on a test system. Complications may
arise with third party modules installed by you. In case of questions, our support is gladly
at your disposal.

10/26



sellxed

5 OpencCart 3.0 Installation - Additions

In order to guarantee smooth operations and the usage of all features please make sure that you
follow the instructions below.

5.1 Configuration of the Main Module

You will find the settings for the main module under "Extension > Modules > ExperCash Base
Module" . Install the module by clicking Install.

By clicking Edit you can configure the main module. Enter all data in the corresponding fields.
Each option is, furthermore, explained in short info texts in the shop.

5.2 Configuration of the Payment Module

After having successfully configured the main module, you can find the settings for the individual
payment methods in your shop under Extensions > Payments . Each payment method is listed
individually. Install the payment methods you wish to offer to your customers. You can carry out
individual settings for each payment method and thereby optimally adapt the payment methods
to your existing processes. The most central options are described in more detail further below.

By clicking on Install the payment method is activated in your shop. Click Edit in order to modify
the configuration of the payment method.

5.3 Direct Capturing of Transactions

The option "Capture" allows you to specify if you wish to debit payments directly or if you first
wish to authorise them and then debit the payment at a later point.

Depending on your acquiring contract, a reservation is only guaranteed for a specific period of
time. Should you fail to debit the payment within that period, the authorisation may therefore no
longer be guaranteed. Further information on this process can be found below.

Different settings between ExperCash and the module

It may be that settings saved in the payment modules overwrite settings saved in
ExperCash.

5.4 Uncertain Status

You can specifically label orders for which the money is not guaranteed to be received. This
allows you to manually control the order before shipment.
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5.4.1 Setting the order state

For each payment method you may select in which state the order should be set to depending on
the booking state. This is the initial state of the order.

5.5 Optional: Validation

Note: It can be that this option is not visible in your module. In this case just ignore this section.

with the option 'validation' you can define the moment when the payment method should be
made visible to the customer during the checkout process. This setting is relevant for modules
where the usage depends on the customer's compliance with specific preconditions. For
example, if a solvency check has to be carried out or if the payment method is only available in
certain countries. In order for the credit check or address validation to also work with European
characters, the charset of the "Blowfish mode" must be set to "UTF-8" for certain PSP settings.

You have the choice between these options:

e Validation before the selection of the payment method: A validation verification is carried
out before the customer selects the payment method. If the customer does not fulfill the
requirements, the payment method is not displayed

¢ Validation after selection of the payment method: The verification of the compliance
occurs after the selection of the payment method and before the confirmation of the order

¢ During the authorisation: The validation verification is carried out by ExperCash during the
authorisation process. The payment method is displayed in any case
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6 Settings / Configuration of Payment Methods
6.1 General Information About the Payment Methods

The plugin contains the most common payment methods. In case a desired payment method is
not included per default, please contact us directly.

In order to be able to use a payment method, it must be activated in your account with
ExperCash as well as in your shop. Information about the configuration of the payment methods
can be found further above.

Below you can find important information for specific payment methods that deviate from the
standard process.

6.2 Information on Payment Status

For each payment method you can define an initial payment status (status for authorized
payments etc.). You hereby define the payment status for each state depending on the
processing type of the order (captured, authorized, etc.). It's the initial status which the order
assumes. Depending on the mutation carried out by you, the status can change.

Important info regarding Order Status

Never set the status to Pending ExperCash or any similar pending status which is
implemented by the module.

6.2.1 Order status "pending" / imminent payment (or similar)

Orders with the status 'pending ExperCash' are pending orders. Orders are set to that status if a
customer is redirected in order to pay but hasn't returned successfully or the feedback hasn't
reached your shop yet (Customer closed window on the payment page and didn't complete
payment). Depending on the payment method these orders will automatically be transformed
into cancelled orders and the inventory will be cleared (so long as the Cronjob is activated). How
long this takes depends on the characteristics of the payment method and cannot be configured.

If you have a lot of pending orders it usually means that the notifications from your webserver to
ExperCash are being blocked. In this case check the settings of your firewall and ask the Hoster to
activate the IPs and User Agents of ExperCash.

6.2.2 Order status "cancelled"

Orders with the status "cancelled" have either been set to that status automatically due to a
timeout, as described above, or have been cancelled directly by the customer.
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6.3 MasterPass Integration: What to keep in mind

If you integrate MasterPass as a payment method in your shop, you have two integration options:
External and Standard Checkout. When using External Checkout, the customer does not have to
provide address data during checkout. The customer only needs a MasterPass account and the
data will be transmitted by MasterPass. In order to use this option as a merchant, you have to
activate this payment method with ExperCash.

Please keep in mind, that using additional functions such as address transmission through
MasterPass, may require the activation of the respective options through ExperCash aktiviert.

In order to use MasterPass in compliance with the MasterCard guidelines, please read the
following information carefully before using this payment method.
6.3.1 Integration Possibilities for MasterPass

MasterPass can be integrated as a normal payment method with redirection to ExperCash or as
an external checkout.

6.3.1.1 MasterPass as a Payment Method

If you like to integrate MasterPass as a normal payment method, activate the payment method
as usual (seeConfiguration of the payment method). In this scenario the customer will first be
redirected to MasterPass and then to the wallet of the issuer.

6.3.1.2 MasterPass as External Checkout

If you integrate MasterPass as an external Chekout, you can minimize the steps towards the
payment radically. The adress transfer and the creation of the account is processed via
MasterPass. If you activate the external checkout, there appears a button in the basket with
which you can jump after the login directly to the last step of the order confirmation. The
creation of the account happens in the background.

For the activation of the external checkout g¢o to Extensions > Modifications > Modules >
ExperCash Base Module > Edit > More . There you'll find all settings for the external checkout:

Scope der Konfiguration: Externer Checkout
Standardkonfiguration |
PSP Active ™ Active [STORE VIEW]
Markieren Sie dieses Feld um den externen Checkout
Uber Zu aktivieren
Externer Checkout Sort Order* 0 [STORE VIEW]
Legen Sie die Reihenfolge fest, in der externe
Checkouts angezeigt werden sollen.
Minimal Order Total* [STORE VIEW]
Define a minimal order total for this checkout to be
available.
Maximal Order Total * [STORE VIEW]

Define a maximal erder total for this checkout to be
available.
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Figure 6.1: Activation of the external checkout.

MasterPass as external checkout is not for all cases available. If this point in the manual doesn't
appear, please make sure to contact us.

6.3.2 Checkout: MasterPass Learn More Button

when using MasterPass as a payment method for standard checkout, it is mandatory to link to
the MasterPass Learn More Page. In order to do this, navigate to Payment Method Configuration.
Paste the link for the Learn More Page into the field 'Description’ for the respective languages.
The field 'Learn More' will now be displayed when choosing a payment method.

We have already collected the most important links for you. You only have to copy and paste the
links into the description field:

® German:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/de/DE/" target="

_blank">Mehr Erfahren </a>
® French:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/fr/FR/" target="

_blank">apprendre plus </a>
® English: <a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/DE/" target="

_blank">Learn More </a>
® Spanish:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/ES/" target="

_blank">aprender mas </a>

* [talian:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/it/IT/" target="
_blank">saperne di pit </a>

® Dutch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/nl/NL/" target="
_blank">Leer Meer </a>

Altiviert Alctiviert , [STORE VIEW]
Dieze Zahlungsmethode aktivieran

Titel MasterPass [STORE VIEW]
Mame der Zahlungsmethode

Beschreibung <3 [STORE VIEW]
href="https:ffwww.mastercard.com'mec_usiwalletle
armmore/de/DE™ target="_blank"=Mehr Erfahren
</g=

Beschreibung der Zahlungsmethode

Figure 6.1: Example for entering a description (Magento). These settings are to be found in the
payment method configuration for MasterpPass.
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[} Payment Information

O MasterPass

VY WITH
MasterPass il

Mehr Erfahren

Figure 6.1: The Learn More Page link should appear in the frontend.

Links for additional languages can be found in this document: https://developer.mastercard.
com/...

6.3.3 Additional information

General and additional information on using the MasterPass trademark and logo in your
webshop are available in the official MasterPass Mechant Branding Requirement Document.
which you can access here: https://developer.mastercard.com/...
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7 The Module in Action

Below you will find an overview of the most important features in the daily usage of the

ExperCash module.

7.1 Useful Transaction Information on the Order

You can find an overview of the transaction information in within the order detail view. Among
others, this information allows for the definite attribution of the orders to their corresponding
transaction, seenin the backend of ExperCash.

[E] orders

Order Detalls Grder D

Payment Details nvoice No

Shipping Details Store Name

Products Store Url:

History Customer.
Customer Group
E-Mail:
Telephone:
Total:
Order Status:
IP Address:
User Agent:
Accept Language:
Date Added.

Date Modified

hitp/idemo.sellxed.comiu

Sascha krisi

Default

info@customwsb.ch

33123456798

78.90€

Pending

1608515547

Mozilla/5.0 (X11; Linux xi B6_64) AppleWebKit/'537 36 (KHTML  like Gecko) Ubuntu Chromium/30.0 1599 114 Chrome/30.0.1599.114 Safari/537 36

de.en-USiq=0.8,en,q=0.6

13/11/2013

13M11/2013

Figure 7.1: Transaction Information in OpenCart.

7.2 Capturing / Cancelling of Orders

7.2.1 Capturing Orders

In order to capture orders, open the transaction manager under Sales > ExperCash Transactions.
Here you will find an overview of all transactions. Search for the order in the field with the order
numbers. By clicking "view" you will open the transaction of the order.
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7.2.1.1 Capturing Complete Orders or Partial Capturing

By clicking the button "Capture Transaction" a new window opens up. You can now capture every
item individually in case you do not wish to send all items at once. The amount of possible partial
captures depends on your contract. Please contact ExperCash directly in order to clarify
questions.

Capturing of Orders in the backend of ExperCash

The transaction management between your shop and ExperCash is not synchronised. If
you capture payments with ExperCash, the status in the shop will not be updated and a
second capturing in the shop is not possible.

In case you do not wish to capture all items of an order, you can close the transaction by clicking
the box.

PARTIAL CAPTURE

With the following form you can perform a partial capture.

Name SKU Type Tax Rate Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)
iPhone product11  product 0% | 1 | 74.24 | 74.24
Flat Shipping Rate  shipping shipping 0% | 1 | 3.68 | 3.68

Total Capture Amount: 77.91 EUR

Close transaction for further captures

Figure 7.1: Capturing of Orders

Partial Capturing

Please find out if the capturing of partial amounts is supported by your ExperCash
contract. If this is not the case, it might happen that the transaction is closed for further
transactions after a partial capture.

7.2.2 Cancel Orders

By clicking "Cancel Transaction", the transaction is cancelled and the reserved amount on your
customer's card is released automatically.
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Capture Transaction Refund Transaction

Figure 7.1: Capture or Cancel in OpencCart.
7.3 Refunding Orders
In order to refund orders, open the transaction information (cf. above).

You can refund individual items or any amount of your choice by modifying the total amount or
the item guantity.

PARTIAL REFUND

With the following form you can perform a partial refund.

Name SKU Type Tax Rate Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)

iPhone product11  product 0% | 1 | 74.24 [ 74.24

Flat Shipping Rate  shipping shipping 0% | 1 | 368 | 368
Total Refund Amount: 77.91 EUR

Close transaction for further refunds

Figure 7.1: Refunds in OpencCart for ExperCash.
Maximal Refund

With our module it is not possible to refund more than 100% of the originally authorised
amount.

Executing a refund will not change the status of the order.
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7.4 Setup a CronJob to Activate the Timed Operations

To activate the timed operations of the plugin (e.g. update service, deleting pending orders, etc.)
make sure that you set up the OpenCart Cron engine. Especially the update function allows you to
automatically retrive additional information or changes of your order directly via the APl of
ExperCash. Please note it could be that in order to use the update feature it may be necessary
that ExperCash activates additional options in your account.

In order to use the timed operations, please schedule a cron job in your server to the following
controller:

https://www.your-shop.com/index.php?route=expercashcw/cron/cron

Here we suggest you use a Cron Engine like for example EasyCron. That way you can This allows
you to open the file (URL) with an external service.
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8 Testing

Before switching from test to live mode it is important that you test the module extensively.

Testing

Do not forget to switch the operating mode from test to live after having successfully
tested the module.

8.1 Test Data

In the following section you can find the test data for the various payment methods:
Credit / Debit Card

VISA 41111111121121211
Expiry Date 12/2020

cvc 123

Konto Nr ELV 1212121212

BLZ 12345679
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9 Errors and their Solutions

You can find detailed information under http://www.sellxed.com/en/fag. Should you not be able
to solve your problem with the provided information, please contact us directly under:
http://www.sellxed.com/en/support

9.1 The Referrer URL appears in my Analytics Tool

when a customer and the notification are redirected via Header Redirection, the ExperCash
Referrer URL might appear in your Analytics Tool thus hiding the original traffic source. However,
most Analytic Tools are able to minimize this problem.

In case you are using Google Analytics as reporting tool, this step by step guide may help you to
exclude the URLs: under bullet point 4.
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10 Compatibility with Third-Party Plugins

The plugins listed below are compatible with our payment modules and allow you to handle
certain tasks in an easier way.

10.1 Birthday and gender in OpencCart

For certain payment service providers it is necessary to check the birthday and the gender of a
customer. OpenCart does not check this by default.

How to enable gender and birthday checks in your shops checkout

1. Add two new custom fields to your checkout via your shops backend under
"Customers > Custom Fields"

2. Modify the order context getters to return the value of your custom checkout field
from the order / session (or wherever the previous step saves the data).

Order Context Getters

® AbstractOrderContext
* getBillingDateOfBirth()
* getBillingGender()

These functions can be found in "system/library/cw/Expercash
/AbstractOrderContext.php".

23/26



sellxed

11 Error Logging

The module will log different unexpected errors or information depending on the configured
level. If there is any issue with the module, this l0og can help identify the cause.

11.1 Log Levels

You can configure the log level in the ExperCash settings.

® Error: Logs unexpected errors only. (Default)
* [nfo: Logs extended information.
® Debug: Logs information helpful for debugging.

11.2 Log Location

The log file is stored in the default log folder of OpenCart. The path is configured in the config.php
of your shop system. (Default Path: {shopRootDirectory}/system/logs or {shopRootDirectory}
/system/storage/l0gs)
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12 Advanced Information

This section of the manual is for advanced usage of the module. The content is for advanced
users with special requirements. Everything in this section is optional and not required for the
daily usage of the module.

12.1 Transaction Object

This section describes how to extract information from a transaction, if you need it for further
processing. E.g. you require more information of the transaction for further processing an order
inyour ERP system.

The code snippets in this section assume your script resides in the root folder of the shop with
the default shop folder structure.

In your script initialize the base of OpencCart.
Opencart 3.x

requi re_once(' config. php');
require_once(DI R_SYSTEM . 'startup.php');
/'l Registry

$registry = new Registry();

/1 Config

$config = new Config();

$config->l oad(' default');

$confi g->l oad(' catal og');

$registry->set('config', $config);

$l oader = new Loader ($registry);

$registry->set('load' , $loader);

$registry->set('db', new DB($config->get('db _type'), $config->get

(' db_hostnane'), $config->get (' db_usernane'), $config->get

(' db_password'), $config->get('db_database'), $config->get('db_port')));

Include the module specific files and set registry.

require_once DIR SYSTEM ' |ibrary/cw init.php';

requi re_once DIR_SYSTEM 'l i brary/cw ExpercashCw Uil . php';

require_once DIR _SYSTEM ' |i brary/ cw ExpercashCw Entity/ Transacti on. php'
ExpercashCw Util::setRegistry($registry);

Now you can load the transaction and then extract the transactionObject.
Load the transaction by Id:

$transacti onByl d = ExpercashCw Entity_Transaction:: | oadByld
($transactionld);
$transacti onObj ect = $transacti onByl d- >get Transacti onChj ect () ;
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Load transactions by Order ID:

$transacti onsByOrderld = ExpercashCw Entity_ Transaction::

get Transacti onsByOrder | d( $orderld);

foreach($transacti onsByOrderld as $transaction){
$transacti onObj ect = $transacti on->get Transacti onoj ect ();
/1 Do sonething with each object
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